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Introduction   

You’ve heard the cliché – we’re living in the era of Big Data. And while this is certainly true for 

many large corporations, even small companies are swimming in data. This data could be in 

Excel files or saved to SharePoint lists; it could be in a SQL or an Access database – yet 

wherever it is, typically, it shares one thing in common: it’s unconnected and siloed.  

 

That’s where Power BI (business intelligence) comes in. A Microsoft product which integrates 

into the Microsoft 365 range of apps, it brings together all your disparate data feeds into 

handy dashboards and reports.  

Ultimately, it allows you to analyse your data while presenting it in a visual and meaningful 

way. And by connecting and visualising your data, organisations can get a great overview of 

their data and crucially, you don’t have to be a data scientist or a programmer to use Power 

BI.   
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While you don’t have to be a data scientist or a programmer to follow this eBook, it would 

help if you had some Microsoft 365 experience, with the following:  

• Familiar with the way files are shared such as in OneDrive / SharePoint  

• As we will be exporting data to SharePoint online, knowledge of how to edit a 

SharePoint page would help  

• Have a basic understanding of how columns work in Excel in terms of how cells are 

structured with specific types of data such as number, currency etc. but don’t worry – 

you won’t see any code or come across any tricky Excel formulae!  

• Familiar with Microsoft 365 in general as the Power BI service sits neatly within this 

ecosystem  

To get the most out of this eBook be sure to sign up to a trial version of the Power BI service 

and also to download the Power BI Desktop app.  
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How is Power BI Licensed?  

There are three kinds of Power BI service per-user licenses: Free, Pro and Premium Per User.  

License type  
Capabilities when workspace is in 

shared capacity  

Additional capabilities when 

workspace is in Premium 

capacity  

Power BI  

(free)  

Access to content in My Workspace. 

Please note you cannot share content 

with this license  

Consume content shared with 

them  

Power BI Pro  

Publish content to other workspaces, 

share dashboards, subscribe to 

dashboards and reports, share with 

users who have a Pro license  

Distribute content to users 

who have free licenses  

Power BI  

Premium Per  

User  

Publish content to other workspaces, 

share dashboards, subscribe to 

dashboards and reports, share with  

Distribute content to users 

who have free and Pro 

licenses  

 
users who have a Premium Per User 

license  
 

Table source: https://docs.microsoft.com/en-us/power-bi/fundamentals/servicefeatures-

license-type  

  

And here are the differences within the Power BI Pro and premium plans. Please note, 

according to Microsoft, a capacity ‘is a dedicated set of resources reserved for exclusive use. It 

https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
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enables you to publish dashboards, reports, and datasets to users, without having to 

purchase per-user licenses.’  

Feature  
Power  

BI Pro  

Power BI  

Premium  

Per user  

Power BI  

Premium  

Per capacity  

Collaboration and analytics   

Mobile app access  ✓  ✓  ✓  

Publish reports to share and collaborate  ✓  ✓    

Paginated (RDL) reports    ✓  ✓  

Consume content without a per-user license      ✓  

On-premises reporting with Power BI Report  

Server  

    ✓  

Data prep, modelling, and visualization   

Model size limit  1 GB  100 GB  400 GB  

Refresh rate  8/day  48/day  48/day  

Connect to 100+ data sources  ✓  ✓  ✓  
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Create reports and visualizations with Power  

BI Desktop  

✓  ✓  ✓  

Embed APIs and controls  ✓  ✓  ✓  

AI visuals  ✓  ✓  ✓  

Advanced AI (text analytics, image detection, 

automated machine learning)  
    ✓  

XMLA endpoint read/write connectivity      ✓  

Dataflows (direct query, linked and 

computed entities, enhanced compute 

engine)  

    ✓  

Analyze data stored in Azure Data Lake  

Storage  

    ✓  

Governance and administration   

Data security and encryption  ✓  ✓  ✓  

Metrics for content creation, consumption, 

and publishing  
✓  ✓  ✓  

Application lifecycle management    ✓  ✓  



  
  
8   

Multi-geo deployment management      ✓  

Bring your own key (BYOK)      ✓  

Auto scale add-on availability (preview)      ✓  

Maximum storage  

10  

GB/user  

100 TB  100 TB  

Table source: https://powerbi.microsoft.com/en-us/pricing/   

  

  

    

  

https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
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The following are the prices on a per month basis.  

Power BI Pro  Power BI Premium  

Per user  Per user  Per capacity  

$9.99  

Per user/month  

License individual 

users with modern, 

self-service analytics 

to visualize data with 

live dashboards and 

reports and share 

insights across your 

organization.  

  

Power BI Pro is 

included in Microsoft 

365 E5.  

  

$20  

Per user/month 2  

License individual users 

to accelerate access to 

insights with advanced 

AI, unlock self-service 

prep for big data, and 

simplify data 

management and access 

at enterprise scale.  

  

Includes all the features 

available with Power BI 

Pro.  

  

from  

$4,995  

Per capacity/month  

License your organization with 

capacity to accelerate access to 

insights with advanced AI, 

unlock self-service prep for big 

data, and simplify data 

management and access at 

enterprise scale— without per-

user licenses for content 

consumers.  

  

Requires a Power BI Pro license 

for publishing content into 

Power BI Premium capacity.  

Enable auto scale with your 

Azure subscription to 

automatically scale Power BI 

Premium capacity.  

Table source: https://docs.microsoft.com/en-us/power-

bi/fundamentals/servicefeatures-license-type  

https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
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For information on pricing, see here https://powerbi.microsoft.com/en-us/pricing/  

    

Power BI – the three parts  

Power BI consists of three main products:  

1. Power BI Desktop  

A Microsoft Windows desktop application. Download it here 

https://powerbi.microsoft.com/en-us/downloads/  

2. Power BI service  

a. An online SaaS service which you use in the browser.  

3. Power BI Mobile  

a. Smartphone app (download it from the above link).  

There are also other tools and apps – see below (this page is the above download link):  

   

https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/downloads/
https://powerbi.microsoft.com/en-us/downloads/
https://powerbi.microsoft.com/en-us/downloads/
https://powerbi.microsoft.com/en-us/downloads/
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This eBook is only covering an introduction to the Power BI service (SaaS) and aspects of the 

Power BI Desktop. Furthermore, the data we are connecting to is an Excel file, a SharePoint 

list, a Microsoft Form, and data pulled from the web, in particular, a Wikipedia entry.  

Difference between Power BI Desktop and Power BI service  

Power BI Desktop is more powerful than the Power BI service. The below Venn diagram is a 

neat summary of the major differences.  

For more information, see https://docs.microsoft.com/en-us/powerbi/fundamentals/service-

service-vs-desktop  

 

Image Source: https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vsdesktop  

  

    

  

  

https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
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Below is Power BI Desktop.  

 

Below is the home of the Power BI service, which sits in a browser. As this is a browserbased 

product, it is connected to Microsoft 365 hence, the app launcher (9 dots) on the top left-hand 

side.  
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The mobile app  

Power BI has downloadable mobile apps which allows you to view content on your 

smartphone and other devices. The key distinction with Power BI’s mobile apps is that it 

allows you to consume content created on the platform without having to develop a separate 

mobile app. In many ways, the mobile app just renders pre-existing content.  

Device  Highlights  

iPhone  

iPhones go everywhere, and the Power BI mobile app for the iPhone 

goes, too. Besides viewing your Power BI reports in a special mobile 

layout view, you can add Power BI to your Apple Watch, and ask 

questions with the Q&A virtual analyst.  

Get started with the Power BI mobile app for iOS.  

iPad  

On the iPad, the Power BI mobile app displays dashboards and reports 

the way they were formatted for the Power BI service. Plus you can 

view your Power BI Report Server and Reporting Services KPIs and 

reports right on your iPad. You can set data alerts in the Power BI 

mobile app to notify you when data in a dashboard changes beyond 

limits you set.  

Get started with the Power BI mobile app for iOS.  

https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-phone-report
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apple-watch
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apple-watch
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apple-watch
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-app-ssrs-kpis-mobile-on-premises-reports
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-iphone-app-get-started
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Android phone  

The Power BI mobile app for the Android phone brings Power BI to 

your pocket, with up-to-date, touch-enabled mobile access to your 

business information. You can filter a report by your geographic 

location. You can scan QR codes with your Android phone and go 

straight to a Power BI dashboard or report.  

Get started with the Power BI mobile app for Android.  

Android tablet  

This mobile app runs on a number of different Android tablets, 

bringing you up-to-date, touch-enabled mobile access to your business 

information. On the Android tablet, the Power BI mobile app displays 

dashboards and reports the way they were formatted for the Power BI 

service. You can mark your favourite dashboards and reports, so you 

can get to them quickly, along with your favourite Power BI Report  

Server and Reporting Services KPIs and reports.  

Get started with the Power BI mobile app for Android.  

Windows  

The Power BI mobile app for Windows 10 runs on any Windows 10 

device, including Windows 10 phones. Along with many of the 

features of the other mobile apps, the Power BI mobile app for 

Windows 10 offers special functionality. For example, you can pin a 

Power BI dashboard to the Windows 10 Start screen from the Power BI 

mobile app. Plus you can run Power BI in presentation mode on 

Surface Hub and in the Power BI mobile app for Windows 10.  

Get started with the Power BI mobile app for Windows 10 devices.  

https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-geographic-filtering
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-qr-code
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-qr-code
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-qr-code
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-favorites
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-favorites
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-favorites
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-favorites
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-favorites
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-android-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-pin-dashboard-start-screen-windows-10-phone-app
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-phone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-phone-app-get-started
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-phone-app-get-started
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Table source: https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobileapps-

for-mobile-devices  

  

    

  

https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
https://docs.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-for-mobile-devices
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The image below is a screenshot of the Power BI Android app:  
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Key Power BI concepts  

The following are some key concepts within Power BI.  

Term  Definition  

Workspaces  
Workspaces are containers for dashboards, reports, datasets, and 

dataflows.  

Datasets  

A dataset is a collection of data that you import or connect to. 

Power BI lets you connect to and import all sorts of datasets and 

bring all of it together in one place.  

Reports  

A Power BI report is one or more pages of visualizations such as 

line charts, maps, and treemaps. Visualizations are also called 

visuals. You can create reports from scratch within Power BI, 

import them with dashboards that colleagues share with you, or 

Power BI can create them when you connect to datasets from 

Excel, Power BI Desktop, databases, and SaaS applications.  

Table source: https://docs.microsoft.com/en-us/learn/modules/introductionpower-

bi/2-what-power-bi  

  

    

https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
https://docs.microsoft.com/en-us/learn/modules/introduction-power-bi/2-what-power-bi
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Preparing your data for Power BI  

Before using Power BI to interact with your data, here are a few tips to ensure that your data 

is suitably prepared. While you don’t have to be a data scientist to use Power BI, the overall 

analysis of your data will only be as good as the data itself.  

The tips below for the preparation of an Excel file but may be used for other data sources, too. 

While Power BI allows you to clean up your data once it has been imported (and this is 

necessary if you are bringing in data from, for example, the web and you have no control over 

the creation of the data), it’s a good idea to try to have the cleanest data as possible from the 

start.  

• All the data in each column should be of the same type of data, for example, it must be 

number, text, currency etc.  

• Think hard about what the purpose of your data is. Do you need all of the information? 

What columns can you remove? Or perhaps you want to add a column from 

elsewhere. In short, reduce your data to its absolute minimum before you use it. And 

remember – if you connect your Excel file to Power BI via OneDrive, if you update the 

OneDrive file, it will be updated in Power BI  

• Flatten all data which appears in a pivot table or matrix format  

• Don’t have any totals rows in your data source  

• If your data is not actually a ‘table’ turn it into a table by selecting Format as a table in 

Excel. This will put a header above each column which will, in turn, be understood as 

the column name in Power BI  

• Name your table and leave out spaces in the table name  

Below is a good example of clean data which is copied from an Excel file. Each column is its 

own data type with simple, functional columns. You can cut and paste it into Excel to follow 

our example.  
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OrderDate  Region  Rep  Item  Units   Unit Cost    Total   

1/6/19  East  Jones  Pencil  95   £                 1.99    £           189.05   

1/23/19  Central  Kivell  Binder  50   £               19.99    £           999.50   

2/9/19  Central  Jardine  Pencil  36   £                 4.99    £           179.64   

2/26/19  Central  Gill  Pen  27   £               19.99    £           539.73   

3/15/19  West  Sorvino  Pencil  56   £                 2.99    £           167.44   

4/1/19  East  Jones  Binder  60   £                 4.99    £           299.40   

4/18/19  Central  Andrews  Pencil  75   £                 1.99    £           149.25   

5/5/19  Central  Jardine  Pencil  90   £                 4.99    £           449.10   

5/22/19  West  Thompson  Pencil  32   £                 1.99    £             63.68   

6/8/19  East  Jones  Binder  60   £                 8.99    £           539.40   

6/25/19  Central  Morgan  Pencil  90   £                 4.99    £           449.10   

7/12/19  East  Howard  Binder  29   £                 1.99    £             57.71   

7/29/19  East  Parent  Binder  81   £               19.99    £       1,619.19   

8/15/19  East  Jones  Pencil  35   £                 4.99    £           174.65   

9/1/19  Central  Smith  Desk  2   £             125.00    £           250.00   
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9/18/19  East  Jones  Pen Set  16   £               15.99    £           255.84   

10/5/19  Central  Morgan  Binder  28   £                 8.99    £           251.72   

10/22/19  East  Jones  Pen  64   £                 8.99    £           575.36   

11/8/19  East  Parent  Pen  15   £               19.99    £           299.85   

11/25/19  Central  Kivell  Pen Set  96   £                 4.99    £           479.04   

12/12/19  Central  Smith  Pencil  67   £                 1.29    £             86.43   

12/29/19  East  Parent  Pen Set  74   £               15.99    £       1,183.26   

1/15/20  Central  Gill  Binder  46   £                 8.99    £           413.54   

2/1/20  Central  Smith  Binder  87   £               15.00    £       1,305.00   

2/18/20  East  Jones  Binder  4   £                 4.99    £             19.96   

3/7/20  West  Sorvino  Binder  7   £               19.99    £           139.93   

3/24/20  Central  Jardine  Pen Set  50   £                 4.99    £           249.50   

4/10/20  Central  Andrews  Pencil  66   £                 1.99    £           131.34   

4/27/20  East  Howard  Pen  96   £                 4.99    £           479.04   

5/14/20  Central  Gill  Pencil  53   £                 1.29    £             68.37   

5/31/20  Central  Gill  Binder  80   £                 8.99    £           719.20   
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6/17/20  Central  Kivell  Desk  5   £             125.00    £           625.00   

7/4/20  East  Jones  Pen Set  62   £                 4.99    £           309.38   

7/21/20  Central  Morgan  Pen Set  55   £               12.49    £           686.95   

8/7/20  Central  Kivell  Pen Set  42   £               23.95    £       1,005.90   

8/24/20  West  Sorvino  Desk  3   £             275.00    £           825.00   

9/10/20  Central  Gill  Pencil  7   £                 1.29    £               9.03   

9/27/20  West  Sorvino  Pen  76   £                 1.99    £           151.24   

10/14/20  West  Thompson  Binder  57   £               19.99    £       1,139.43   

10/31/20  Central  Andrews  Pencil  14   £                 1.29    £             18.06   

Creating a workspace and report in Power BI  

When you think about a Power BI workspace, think of a container which houses dashboards, 

reports, datasets, and dataflows. There are two types of workspaces: My workspace and 

workspaces.  

My workspace is a personal workspace where you can work on your own content whereas 

workspaces are collaborative spaces which are used to work on Power BI content.   

Getting data from Excel   

For our first workspace and report, we are going to use the above data which is in an Excel 

file.   
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We’re going to upload it to the Power BI service and present the data in a visually appealing 

way. Furthermore, we’ll export the data to Teams and SharePoint online.  

1. Select Workspaces → Create a workspace. You have the option to upload an image, give it 

a name and a description. We’re going to upload an image of stationary and call it 

Stationary review.   

 

2. When our workspace is created, it will be empty. We’re going to select New and Dataset, 

Create a dataset to use in a report.  
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3. On the Get Data page, select Create new content and Files.  

 

4. You have the option of selecting Local File, OneDrive-Business, SharePoint-Team Sites, 

and also Learn about importing files. Choose the first option – Local file. We’re selecting 

an Excel file called Sales Data.  
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5. You have two options - Upload your Excel file to Power BI. It now appears in the Stationary 

review workspace.  

 

6. Next, we’re going to use Sales Data to create a report by selecting +New → Report and 

Pick a published dataset → SampleData and Create. The following page appears:  

 
7. First, let’s look at Fields which is on the right hand-side of the screen. Here you will see the 

data as referenced in the original Excel file:  
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8. If we select Region, Rep and Total, we see the raw data:  

 

9. However, we can make this more interesting by using the many options that appear in 

Visualizations.  
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10. Below we have used a Stacked bar chart and have enlarged the chart in order to see all 

the reps. To make any chart bigger, just stretch it from the bottom corner.  

 

11. It’s always wise to save your report by selecting File → Save this report.  
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12. The next visualization we’ll do is a Clustered bar chart and we’re selecting the 

following fields: Item and Total.  

 

13. Once you save your report, you can then export it. When it is saved, it looks like this:  

 

  

  

    

  

  



  
  
28   

14. When you select Home, we can see it has a Favourites and frequents, and also is where we 

select Workspaces.  

 

Sharing data from Power BI  

Now that we have created our first report based on our Excel file, we can export it or share it. 

It can be exported to PowerPoint, as PDF or back to Excel.  

Under Share, there are the familiar sharing options from other Microsoft 365 products such as 

OneDrive and SharePoint. However, the settings include the following option: Allow 

recipients to build content with the data associated with this report (by default it is 

deselected).  
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Please note the following conditions when it comes to sharing:  

• You can share with people who are inside and outside of your organisation  

• When you share a report, generally they can view it, they can hover over the visualisations 

to glean more data, but they cannot edit it  

• You can allow people in your organisation to share with other people in your organisation  

• You can share from Favourites, Recent, My Workspace and from other workspaces if you 

have the permission  

• When you share you must have a Power BI Pro or Premium Per User license. Also, the 

people that you share with also need the same license, too o To see your report, they 

must sign into Power BI o External people can’t edit content  
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For more about sharing, see here https://docs.microsoft.com/en-us/powerbi/collaborate-

share/service-share-dashboards  

Sharing data in Teams  

You can share your report to your colleagues within Teams.   

1. In Power BI, select Chat in Teams and when you start writing the name of your Team, it 

will appear. We’ve created a team called Stationary review in Teams, which we select, and 

then Share.  

 

2. It appears in the Team as a conversation on the General channel. Once clicked, you have a 

similar interface as the Power BI service. Also, you will be prompted to add Power BI as an 

app to Teams.  
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Sharing data in SharePoint  

Go to the SharePoint site where you want to publish the report. Create a page and then add 

the Power BI webpart option:  
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On this SharePoint page, you will be prompted to add a report by inserting a link.   

Back in Power BI, you will get the link by selecting File → Embed in SharePoint Online.  

 

The Details pane in SharePoint will appear and this is where you paste your link.  
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Please note, according to Microsoft, ‘Embedding a report in SharePoint Online doesn't 

automatically give users permission to view the report - you need to set view permissions in 

Power BI.’  

Also, ‘Users viewing a report in SharePoint need either a Power BI Pro or Premium Per  

User (PPU) license or the content needs to be in a workspace that's in a Power BI  

Premium capacity (EM or P SKU).’  

For more information, see here https://docs.microsoft.com/en-us/power-

bi/collaborateshare/service-embed-report-spo  

Getting data from OneDrive for Business  

For this example, we’ve downloaded a sample file form Microsoft  

(https://docs.microsoft.com/en-us/power-bi/create-reports/sample-financial-download) 

which has a lot of dummy data. It’s a great file to use as it’s from a trusted source and has lots 

of data in it.   

On our Stationary review workspace, we’re uploading it by selecting + New → Upload a file.  
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This time we’re going to select a file which sits in your OneDrive or you have the permission to 

access in another user’s OneDrive. This has the advantage over uploaded from your PC as 

Power BI will check the file periodically to see if there are any changes; and if there are, the 

changes will be updated to Power BI.  

As the Power BI service is part Microsoft 365, it automatically signs in has access to your 

OneDrive files.  

 

  Select Import Excel data into Power BI.  
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Once it’s in our workspace, there are a number of options when we select More options:  

 

1. Get quick insights.  

Promptly, quick insights brings back just under 40 different visualizations. It’s a great 

place to start as long as you have enough data in your file to generate all the 

visualizations.   
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If you click on any of the visualizations, it will be enlarged thus giving a more detailed and 

interactive view. Below is the full screen version of the visualisation.   

 

Turning your data into a map  

In the next example, we’re going to create a map to details our sales.  

1. Select + New → Create report:  
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3. Stretch out the map so it fits nicely on your screen. As you can see, it’s still a blank map as 

have yet to select the Country field. Once we do, our map comes alive and we see where 

our units are being proportionately sold; they appear as blue circles over Canada, US, 

Mexico, France, and Germany.  

 

4. Next, we’re going to add a legend which gives our countries a different colour.  
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5. Once you have it saved, it can be shared in the same way as our previous example i.e.  

to Teams, SharePoint Online, or exported as a PDF, Excel file, or a PowerPoint 

presentation.  

Getting data from a SharePoint list  

Although SharePoint lists are an ideal place to store data, within SharePoint itself it’s not a 

particularly visual medium. For example, below is a screenshot of a SharePoint list containing 

financial data, and while the data is structured and easy to update, if we bring it into Power BI 

we can present it in a more appealing way.  
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1. Open Power BI Desktop and select Get data → More → Online Services. The first option 

is a SharePoint Online List. Enter the root URL of the SharePoint site for the 

SharePoint list and select OK.  

 

2. If prompted to use you Microsoft account, sign in. Select the table which is - in effect – 

the SharePoint list.   
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3. Make sure you have selected Report – see below:  

 

4. Select your visual. The below example is a Stacked bar chart - a nice visual which 

details the Count of Gross Sales by Country and Product.  

 

Getting data from Microsoft Forms  

Microsoft Forms is another product which collects exportable data. In the below example, we 

have a short survey of 10 responses.  
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In order to get the data into Power BI, we have two options. Export the data to Excel and then 

import it to Power BI or create a SharePoint list based on the Excel file, and then import or 

link it to Power BI.  

We’re going to use option one, export to Excel.  

1. Select Open in Excel. The data comes in structured in columns with column headers – 

this makes it easy to organise the data once in Power BI.  

 

2. In Power BI Desktop, select Import data from Excel and choose your Excel file.  

Select the required table → Load.  
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3. Below, we’re using a Line and stacked column chart to detail the results of our survey.  

 

Another option worth mentioning if you want this to be automated, is to create a Power  
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Automate flow that triggers each time a survey response is received, that then copies the 

response into a SharePoint list. Then you base your Power BI reports on that SharePoint list 

data.  

Getting data from the web  

You can import data from the web by selecting Get data → Web and import it into Power BI 

Desktop.  

 

For this example, we’re going to use a Wiki page entry on the bestselling automobiles:  

https://en.wikipedia.org/wiki/List_of_best-selling_automobiles  

When prompted, insert the URL. Next, it brings up many tables that we can import.  

However, we’re sticking to just one – Brand bestsellers[Edit].  

  

https://en.wikipedia.org/wiki/List_of_best-selling_automobiles
https://en.wikipedia.org/wiki/List_of_best-selling_automobiles
https://en.wikipedia.org/wiki/List_of_best-selling_automobiles
https://en.wikipedia.org/wiki/List_of_best-selling_automobiles


  
  
45   

 

However, once we bring in the data, we must ensure that the columns are correctly labelled.   

1. We’re going to rename and/or remove columns in order to showcase the following data:  

a. Brand  

b. Automobile  

c. Production  

d. Units Sold  

We’re going to remove the column for Notes.  
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2. Under fields, select each column and rename it in line with the original column name in 

Wikipedia.  

 

    

3. Once arranged, our data looks like the following.   
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4. As the data in the Units Sold column is unstructured – it contains numbers and words – 

we’re going to clean it up by selecting Transforming data and Replace Values for some of 

the items in that column. Basically, we want to remove references to footnotes and other 

miscellaneous text.   
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5. Next, make sure that your values are in the order that you want them to appear. You don’t 

have to number them, but we have; what’s important is that they appear in the order that 

you want them to appear in.  
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6. Once we have our data saved, we’re going to publish it to a workspace in the Power BI 

service by selecting Publish and choosing a workspace that we’ve created called Car 

Sales.  

 
7. Next, we’re going to turn our data in a Treemap. When we select the Treemap 

visualization, our data is displayed in boxes. 
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8. When we hover over a box, we get the data relating to each car brand.  

 

Getting data from the Dataverse  

As Microsoft’s Dataverse stores and manages data in tables, it’s ideal to connect to Power BI.   

For more information, see https://docs.microsoft.com/en-

us/powerapps/maker/dataplatform/data-platform-powerbi-connector  

Please note, as the above link states, you’ll need the following items:  

1. Download and install Power BI Desktop. Download Power BI desktop here.  

2. Dataverse environment with maker permissions to access the portal and read 

permissions to access data within tables.  

3. You must have the appropriate Power BI license to build and share Power BI reports.  

4. To use the Dataverse connector, the Enable TDS endpoint setting must be enabled in your 

environment. More information: Manage feature settings  

Getting data from other sources  

There are many different data sources that you can connect to and you can connect to 

multiple data sources at the same time.  
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Here is a list of file sources that you can connect to:  

• Excel  

• Text/CSV  

• XML  

• JSON  

• Folder  

• PDF  

• Parquet  

• SharePoint folder  

  

  

  

  

    

Here is a list of all databases that you can connect to:  
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Databases     

SQL Server database  

Access database  

SQL Server Analysis Services 

database  

Oracle database  

IBM Db2 database  

IBM Informix database 

(Beta)  

IBM Netezza  

MySQL database  

PostgreSQL database  

Sybase database  

Teradata database  

SAP HANA database  

SAP Business Warehouse 

Application Server  

SAP Business Warehouse  

Message Server  

Amazon Redshift  

Impala  

Google BigQuery  

Vertica  

Snowflake  

Essbase  

Actian (Beta)  

AtScale cubes  

BI Connector  

Data Virtuality LDW (Beta)  

Denodo  

Dremio  

Exasol  

Indexima  

InterSystems IRIS (Beta)  

Jethro (Beta)  

Kyligence  

Linkar PICK Style /  

MultiValue Databases 

(Beta)  

MariaDB (Beta)  

MarkLogic  
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Table source and more information, see here: https://docs.microsoft.com/enus/power-

bi/connect-data/desktop-data-sources  

  

Data refresh  

Depending on how you connect your data, it will refresh differently. According to Microsoft, ‘A 

Power BI refresh operation can consist of multiple refresh types, including data refresh, 

OneDrive refresh, refresh of query caches, tile refresh, and refresh of report visuals.’  
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Here is a quick guide:  

Storage mode  Data refresh  
OneDrive 

refresh  

Query 

caches  
Tile refresh  

Report 

visuals  

Import  

Scheduled 

and 

ondemand  

Yes, for 

connected 

datasets  

If enabled 

on 

Premium 

capacity  

Automatically and 

on-demand  
No  

DirectQuery  
Not 

applicable  

Yes, for 

connected 

datasets  

If enabled 

on 

Premium 

capacity  

Automatically and 

on-demand  
No  

LiveConnect  
Not 

applicable  

Yes, for 

connected 

datasets  

If enabled 

on 

Premium 

capacity  

Automatically and 

on-demand  
Yes  

Push  
Not 

applicable  

Not 

applicable  

Not  

practical  

Automatically and 

on-demand  
No  

Table source and more information, see here https://docs.microsoft.com/enus/power-

bi/connect-data/refresh-data  
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The top ten visualizations  

There are many visualizations that come out-of-the-box with Power BI. Also, there are many 

being created by third parties, too.   

Here are our top ten.  

1. Bar charts  

Call us old fashioned, but there’s something elegant and straight forward about a simple 

bar chart.  

 

2. Doughnut charts  

Another classic, and for a very good reason – it gives you a clear, unambiguous view of 

who is devouring most of the data.   
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For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-doughnut-charts  

3. Scatter charts  

Dots floating around in clear, clean space presents data in an original and simple way.  

 

For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-scatter  

4. Waterfall chart  

Although the waterfall may at times look like something out of Minecraft, it has a certain 

charm – and solid data presentation.  

 
For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-waterfall-charts  
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5. Maps  

It’s hard to get a better way of reporting country-by-country data than a map.  

 

For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/desktop-shape-map  

  

6. Tree maps  

What could be nice than an interactive wall of beautifully colour data bricks?   

 

  

For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-treemaps  

  

7. Q&A  

Driven by AI, this does exactly what it’s called – query your data as if it’s your very own 

data analyst.   
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For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-q-and-a  

  

8. Funnel chart  

Another simple and effect way of presenting data – check what’s in your linear funnel.  

 

For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-funnel-charts  

  

    

9. Gauge  

What’s more visual than a rev-counter data visual that displays your data against a 

targeted goal?  
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For more information, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-radial-gauge-charts  

10. Key influencers  

Last, but not least, this one of the finest AI driven visualizations on the market today that 

allows you to Q&A your data – more on this in the next chapter of this eBook.  

 

For more about visualizations, see here https://docs.microsoft.com/en-

us/powerbi/visuals/power-bi-visualization-types-for-reports-and-q-and-a  

Furthermore, for other Microsoft visualizations and those which have been created by third 

parties, see here https://appsource.microsoft.com/en- 

US/marketplace/apps?product=power-bi-visuals  

  

  

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-reports-and-q-and-a
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/en-US/marketplace/apps?product=power-bi-visuals


  
  
60   

Key influencers visualizations  

Key influencers is an AI-driven visualization which tries to drill down into your data in order to 

figure out the key reasons that are influencing aspects of your data. In summary, it tries to 

understand the reasons why your KPIs are moving in one direction or another.  

Please note: Key influencers can be used for both the Power BI service and the Power BI 

Desktop. In this example, we’re using Power BI Desktop for a better experience.  

1. In Power BI Desktop, select Get data and choose a file. We’re selecting our Financial 

Sample Excel file and one specific sheet.  

 
2. Once loaded, you can see the columns from the Excel sheet.  
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3. Select the Key influencers visualization.  

 
When you select the Key influencers visualization, you must input fields in the Analyse 

section and then add more fields to the Explain by section. In our example, we have 

added Profit to the Analyse section; and we have put every other field in the Explain by 

section.  
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4. The above settings return the following:  

a. Key influencers show us the top contributing factors to the selected item.  

b. Top segment shows the top segments that contribute to the selected item.  

c. In our example, the dropdown box is a binary choice between Increase and 

Decrease.  

d. On the right hand-side we see a graphic which is a visual interpretation.  

e. The left pane contains the actual list of key influencers.  
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5. We can also filter the data by selecting Filters. In the below example, we have filtered our 

data to only include references to Canada and France, and the visualizations adjusts 

accordingly.  
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6. Now that we have our key influencers report in Power BI Desktop, let’s save it to the 

Power BI service. We have created a workspace called Key influencers; this is going to be 

the destination for the above report.  

7. On the Home section of the ribbon, select Publish. We’re given a choice as to where we’ll 

publish to. In our case, we’re selecting Key influencers.  

 

8. Once published to the Power Bi service, you have the option to get quick insights or to 

further share within others as a link or in in Teams.  

  

  



  
  
65   

For more information, see here https://docs.microsoft.com/en-us/powerbi/visuals/power-bi-

visualization-influencers  

Dashboards  

A Power BI dashboard is a single page which contains a number of visualizations. When used 

well, they give the viewer a high-level summary of an organisation’s activity.  

A dashboard is based on data which comes from reports. In essence, a dashboard can contain 

multiple visualizations of data from many reports.  

While a dashboard may sound similar to a report, there are differences.  

Capability  Dashboards  Reports  

Pages  One page  One or more pages  

Data sources  
One or more reports and one or more 

datasets per dashboard.  
A single dataset per report  

Drilling down in 

visuals  

Only if you pin an entire report page 

to a dashboard.  
Yes  
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Available in  

Power BI  

Desktop  

No  
Yes. Can build and view reports 

in Power BI Desktop.  

Filtering  
No. Can't filter or slice a dashboard. 

Can filter a dashboard  

Yes. Many different ways to 

filter, highlight, and slice.  

 
tile in focus mode, but can't save the 

filter.  
 

Featured  
Yes. Can set one dashboard as your 

featured dashboard.  
No  

Favourite  
Yes. Can set multiple dashboards as 

favourite’s.  

Yes. Can set multiple reports as 

favourite’s.  

Natural 

language 

queries (Q&A)  

Yes  

Yes, provided you have edit 

permissions for the report and 

underlying dataset.  
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Set alerts  
Yes. Available for dashboard tiles in 

certain circumstances.  
No  

Subscribe  Yes. Can subscribe to a dashboard.  
Yes. Can subscribe to a report 

page.  

Can see 

underlying 

dataset tables 

and fields  

No. Can export data but can't see 

tables and fields in the dashboard 

itself.  

Yes  

Table source: https://docs.microsoft.com/en-us/power-bi/create-

reports/servicedashboards  

  

Creating a dashboard   

1. While in your workspace (in our example, our workspace is Stationary review) select +New 

and Dashboard. We’re going to name it World View.  

2. Next, we’re going to add a tile be selecting Edit → Add a tile.  
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3. We are given the following choices:  

a. Web content  

b. Image  

c. Text box  

d. Video  

e. Read-Time Data  

4. Let’s select Text box. We’re going to title our dashboard ACME Corporation – Global Sales. 

Within the pane, you can resize and change the font too.  

 
5. Next, we’re going to bring in the data map from our previous example. Open up the data 

map and select the Pin to a dashboard icon.   

 

6. When prompted, choose Existing dashboard and in our example, we’re pinning it to World 

Sales.  
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7. We now have two tiles on our dashboard.  

 

8. Let’s add some tiles based on the Excel file Financial Sample and quick insights.  

We’ve added:  

a. Average of Sale Price  

b. Discounts  

c. Units Sold  
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d. Average of manufacturing price  

 
9. Lastly, if we select Chat in Teams, a link will be posted to a conversation.  
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Ask a question about your data  

At the top of our dashboard – and also on other visualizations too – you will be prompted to 

Ask a question about your data.  

 
It helps if you have some knowledge of how your data is structured in terms of what columns 

exist as basically, when you ask a question - and hope to get an answer – you are really 

comparing data in one column to another or asking binary questions such as what the 

highest or lowest price of data in another column is.  

If we start asking the following question What is the… we get these options:  

 

If we select What is the highest sale price, the answer appears:  
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Furthermore, there are predefined questions which act as a starting point. By default, our 

predefined questions cover the average sale, count segments, maximum sale price and many 

more.  

 

Creating an App  

Power BI allows you to create apps. When you think of a Power BI app, think of it as being 

made up of reports and dashboards. The purpose of creating an app is to share it with a 

broad audience within your organisation. When you share an app, users can:  

• Look but cannot modify its content  

• View it in the Power BI service a mobile app  

• Get updated automatically or whenever you decide to update them  

For more information on apps and how the licencing works, see here 

https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-createdistribute-apps  

  

    

So let’s create our first app.  

1. As apps are created in workspaces, let’s open our Stationary workspace. You’ll see on the 

right hand-side of the below screenshot, there’s the option to Include in app, and at the 

top of the page, Create app.  
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What we are doing is adding the parts below to your app – we’re adding everything on 

offer to give our app as much content as possible.  

 

    

2. Give your app a name and a description. You can give the app a colour, too.  

 

3. When you create your app, you’ll get a link to it.  
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4. Below is our app.  

 

Once your app has been published, you can share it in Teams, post a comment (with the @ 

you can mentioned somebody in your organisation), and see related content, among other 

options. There’s also a full screen mode which is ideal if you want to highlight KPIs in your 

physical office setting, such as a reception.   
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Next steps  

In this eBook we have touched on some of the most powerful features that Power BI has to 

offer. However, as it’s a very powerful tool, the examples which we have covered are only a 

starting point for your Power BI journey.  

For example, you can learn more about:  

• Datasets: For more information, see here https://docs.microsoft.com/en-

us/powerbi/connect-data/service-datasets-hub  

• Goals: For more information, see here 

https://powerbi.microsoft.com/enus/blog/introducing-goals-in-power-bi/  

Apps: There are many third-party apps which can connect to your version of Power  

BI. These apps simply plug into Power BI in a similar way that apps plug into Teams. For 

more information, see here https://powerbi.microsoft.com/enus/blog/distribute-to-large-

audiences-with-power-bi-apps/  
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• Deployment pipelines: This feature allows you to manage and control the lifecycle of your 

data and is based on three stages: The Deployment phase; the Test phase, and the 

Production phase. For more information, see here  

https://docs.microsoft.com/en-us/power-bi/create-reports/deployment-

pipelinesoverview?WT.mc_id=welcome_page  
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